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Introduction
Welcome to Presentation Plus!    This unique multimedia teaching resource is designed to help facilitate your classroom 

presentation of the ideas and concepts contained in your textbook.    Many of the teaching resources you have come to rely on are 

now provided in one easy-to-use product. 

The Presentation Plus! software is based on Microsoft PowerPoint 97.    However, you don't need the PowerPoint software to 

use this tool since the Microsoft PowerPoint Viewer is included with the slide shows.    If you do have access to Microsoft 

PowerPoint 97 (or a later version), you can customize the presentations to meet your particular classroom needs¾add extra 

slides, rearrange slides, and update information.



Setting Up Your Equipment
Before you begin using the Presentation Plus! system, make sure that you have your equipment connected properly.    If you 

experience difficulties working with a presentation, refer to the troubleshooting tips.

To use the Presentation Plus! system, you need the following equipment:

 

· IBM PC (or 100%-compatible) computer

· Pentium 90 MHz microprocessor (or higher)

· 4x CD-ROM (or faster)

· Windows 95 SR-2 (or a later version)

· 16 MB memory (32 MB or more recommended)

· video card (1 MB memory or more)

· color monitor or projector with high color (640 x 480 or higher) resolution

· hard drive (20 MB free)

· videodisc player (to view the full videos)

· pointing device

· printer (optional, but recommended)

To utilize the Internet features included in Presentation Plus!, you must have Netscape Navigator 4.0 or Microsoft Internet 
Explorer 4.0 (or a later version) installed on your computer.    You must also have an Internet connection.



Choosing a Presentation
Follow the instructions provided below to choose and then work with a presentation.    The Microsoft PowerPoint Viewer is 

available on the Presentation Plus! CD-ROM if you do not have the PowerPoint 97 (or later) software.

To choose a presentation using the Viewer:

1. Make sure that you have installed the PowerPoint 97 Viewer (or a later version) onto your computer system.    Refer to the 
installation instructions if you need assistance.    (See the system requirements for Presentation Plus!)

2. Click on the Start button shown on the Taskbar.

3. Highlight the Programs option and then choose Microsoft PowerPoint Viewer.

4. Click on the Look in pop-up menu that appears at the top of the window.    Then select your CD-ROM drive.

5. Choose a presentation. 

6. Click on the Forward button to display the Contents slide. 

7. Use the navigation buttons to view the slides.    Click on the Help button for step-by-step instructions.

8. To end a presentation, click on the Exit button or press the Esc (escape) key.

To choose a presentation using PowerPoint:

If you have PowerPoint 97 (or a later version), you can use it to display a presentation.

1. Start Microsoft PowerPoint and choose to open a presentation.

2. Click on the Look in pop-up menu that appears at the top of the window and then select your CD-ROM drive.    If you copied 
the presentations to your hard drive, select the location where the presentations are stored.

3. Choose a presentation. 

4. Click on the View menu and choose Slide Show.

5. While viewing a presentation, click on the navigation buttons to view the slides.    Click on the Help button for step-by-step 
instructions.

6. To end a presentation, click on the Exit button or press the Esc (escape) key.

NOTE:    If you are using PowerPoint 2000, the presentation may seem to freeze when you view the show.    The 
presentation is not frozen; it is being loaded into memory, which may take a minute or more.    To alleviate this problem, 
use the PowerPoint Viewer that is included in the "Media Installers" folder of your Presentation Plus! CD-ROM.



Navigating a Slide Show
Using the Presentation Plus! software is easy.    Once you select a presentation, just use a mouse or another compatible pointing 
device to step through a slide show.    As you view a unit or chapter slide show, you can use the following buttons/keys to navigate 
a presentation:

    Use the Forward button to move forward one slide at a time through the software. 

    Click on the Back button to move back to the previous slide. 

 Click on the Home button to display the Contents slide.

 To go to the beginning of a section or part, click on the Section Start button.    Depending on where you are 
working in a presentation, click on this button to return to the slide from which you accessed a particular option. 

 Click on the Exit button or press the Esc (escape) key to end a slide show. In a linked presentation, the Exit 
button will return to the slide show from where the linked presentation was chosen. 

    Use the Speaker button to listen to the audio provided on selected slides.

 Click on the Speaker Off button to turn any audio off.

 Click the Help button to access the help feature.

 

The presentations may also include the Map/Chart button.       Click this button to navigate to the maps and charts that are 
relevant to the Lecture Notes you are viewing.



The presentations may also include the Map/Chart/Photograph button.       Click this button to navigate to the maps, charts 
or photographs that are relevant to the assessment question you are viewing.
Press the Space Bar, down arrow, Enter, PgDn key, or the letter N to display the next item on a slide.    Clicking the left mouse 
button also displays the next item.    If the last item is already displayed, the program will display the next slide.

Use the Backspace key, up arrow, PgUp key, or the letter P to move to the previous item on a slide.    If no items appear on a 
slide, the program will go to the previous slide.

Press the letter B to display a black screen.    Press it again to view the current slide.

Press the F1 key while viewing a slide show to display a complete list of the navigation controls.

The presentations also include hyperlinks.    A hyperlink to another slide or to a different part of a presentation appears as colored, 
underlined text.    When you click on this kind of hyperlink, the program takes you immediately to the location associated with the 
link.    If you accidentally select a hyperlink, you can click on the appropriate navigation button to return to where you were.



Customizing a Presentation
The Presentation Plus! software was created using Microsoft PowerPoint 97.    Although you do not need PowerPoint 97 to 
view the slides, you can customize any of the presentations if you have PowerPoint 97 (or a later version).    Follow the steps 
listed below to customize a presentation.

To customize a presentation:

1. Install PowerPoint 97 (or a later version) on your computer if it is not already installed.

IMPORTANT:    If you are not thoroughly familiar with PowerPoint, practice creating your own presentations.    You could also 
work through a tutorial to learn how to use the powerful features available in this program.

2. Before you make any changes to a PowerPoint presentation, you should create a folder on your hard drive.

3. Since you cannot make changes to the presentations on the CD-ROM, copy the presentation(s) to your hard drive.    Copy 
them to the folder you have created.    Relevant video and linked presentations will need to be copied into the folder as well.

If you have enough hard disk space, you can copy all of the presentations and video to your hard drive.    Approximately 650 
MB disk drive space is needed.    Each presentation includes all of the art, audio, and links in its own file. 

4. Since you copied the files from a CD-ROM, they are set to read-only.    If you change a slide show, you must save it under a 
different name; you can also use Microsoft Windows Explorer to change the properties for these files.    Right-click on a file 
name that you copied to your hard drive, choose Properties, and then turn off the read-only attribute.

5. Customize the presentation to meet your classroom needs.    Refer to the suggestions and tips listed below before you make 
any changes to a presentation.

· If you have deleted any art element (e.g., a button or a picture) from a presentation, you will need to copy the element 
from another presentation or slide within the current presentation if you want to insert the element back into a slide 
show.    Separate art elements are not provided as part of Presentation Plus!

· All of the chapter and unit presentations use the custom show feature for all features accessed through buttons on the 
left side of the slides. You should fully understand how custom shows function before making any modifications to these 
slides.    If, for example, you add a slide to a feature, you must also update the corresponding custom show list so that 
PowerPoint will know how to display the new slide.

· Changes to the Chapter Introduction, Lecture Notes, and Chapter Assessment slides can easily be made since 
these slides are not part of a custom show.    You can add slides, delete slides, and update slides as needed.

· Hyperlinks and action settings are used to control the action for many of the buttons found in a presentation.    Making 
changes to a hyperlink action setting is relatively straightforward.    However, a special launcher program (fscstart.exe) 
controls how the Puzzles, Interactive Tutor Self-Assessment Software (ITSA), Help, and the Internet Connect 
buttons operate.    If you change any of these buttons or add new buttons, you need to understand the syntax for the 
launcher program.    To use the launcher program, choose to assign an action setting to an object.    Indicate that you 
want to add a setting that runs a program.    Enter the launcher program name along with the appropriate switch to 
perform the desired action. 

To start the puzzle software, use...    fscstart /AR2 /1

To start ITSA, ... fscstart /AR2 /2 /fsc.[unit#].[chapter#].[section#]

To display the help information, ... fscstart /AR2 /3 101

To launch tarvol2.glencoe.com, ... fscstart /AR2 /5 /111

  

** Place the correct numeric value in place of the brackets and information contained within them. 





Troubleshooting Tips
Glencoe provides toll-free telephone assistance for teachers who experience difficulty while using our software or templates.    
Before calling for assistance, please check the following:

· Is your computer working properly?    On the same computer, try some other software that you know is working.

· Can you repeat the problem? 

· Does the problem occur at the same point each time?

· Review the list of troubleshooting tips below to see if your problem is identified.

In order for the Support Center to help you as quickly as possible, have the following information at hand when you call for 
assistance:

 

· exact title and ISBN number of the software from the disk label or package

· brand, model, and configuration of the computer and printer you are using

· version of the operating system installed on your computer

  

The Glencoe Support Center toll-free number is 1-800-437-3715.    The Support Center is available from 8:00 a.m. to 6:00 p.m. 
Eastern Time.    You can also contact the Support Center on the Internet at the following e-mail address:  epgtech@mcgraw-
hill.com

Troubleshooting Tips

The presentation is difficult to read when displayed on a screen. 

The quality of the images projected through PowerPoint depends on several factors.    Make sure that you are displaying the 
image onto a reflective surface¾not a blackboard or other similar surface.    Using a better screen can greatly improve the display 
quality.    Darken the room if possible.    Check the quality of your projector.    This, too, greatly impacts the display quality.

The navigation buttons do not seem to work properly.

Click the Exit button or press the Esc (escape) to exit the slide show.    If you are using the Viewer, choose the presentation again 
to start the slide show at the beginning.    If you are using PowerPoint 97, press the Home key to scroll to the first slide in the 
presentation and then choose Slide Show in the View menu to start the presentation at the beginning.

Clicking Exit in an ancillary presentation does not go back to the original presentation.

Your version of PowerPoint 97 is not the latest version.    Use the PowerPoint Viewer that is included on your Presentation 
Plus! CD-ROM to view presentations or download the latest Microsoft Office 97 Service Release from 
http://officeupdate.microsoft.com

Clicking the right mouse button does not move backward.

Using the Viewer, click on the Options button that appears when you first start the Viewer.    Change the settings so that a right-
click does not display the pop-up menu.    Using PowerPoint 97, click on the Tools menu, choose Options, and click on the View 
tab.    Turn off the setting so that the pop-up menu does not appear on right-clicks.

Colors on the slides do not seem correct.

The Presentation Plus! software requires that you set your monitor to high-color (16-bit) or better.    If your monitor is set for 256-
colors, the quality of the images as they appear on your screen may not be very good.    (See the next tip for instructions on how to 
check or change your color settings.)



How do you set the screen resolution and colors?

Depending on your computer system and projector, you may need to set your monitor to 640 x 480 resolution.    Using these 
instructions, you can also change the color setting.    Right-click on the Desktop.    From the pop-up menu, choose Properties, and 
then click on the Settings tab.    Make the necessary changes on the Settings screen. 

The highest color setting mode is 256-colors. 

For best results, upgrade your video card and driver to support high-color (16-bit) mode or better.    If you are using a SuperVGA 
monitor, you should not have to change your monitor.    The various levels of color settings are more a factor of the video card and 
how much memory it has.

While viewing a presentation, some portions of the screen are not updated. 

Ideally you want to display Presentation Plus! at 800 x 600 or higher resolution. Some video drivers may have difficulty displaying 
full-color slides in 800 x 600 (or higher) resolution.    An update to your video driver may be available from the equipment vendor.    
If updating your video driver does not correct the problem, right-click on the Desktop.    From the pop-up menu, choose Properties 
and then click on the Settings tab.    Change the resolution to 640 x 480.    You may also have to change your projector equipment 
to display in the same mode. 

The text is not clear on the projected image, but the text is okay on the monitor. 

The resolution for a projector needs to match the resolution for your monitor.    If your monitor is set to 800 x 600, for example, text 
may look squeezed on a projected image.    Refer to your projector's manual for instructions on setting the display resolution.

Audio segments do not play. 

Make sure that your speakers are turned on and that the volume is set properly.    On some versions of Windows 95, there is a 
small speaker icon in the lower, right corner of your screen.    Click on it and then adjust the volume settings if necessary.    If the 
audio files still do not play but other WAV files play correctly on your machine, you may need to install the correct audio CODECs. 
In Windows, Click Start, Settings, Control Panels, Add New Hardware.    Click No when asked if you want Windows to search 
for new hardware.    Select Sound, Video, and Game Controllers, choose Microsoft Audio Codecs under manufacturers, and 
select the ADPCM Codec.    Follow the directions on the screen and insert the Windows disc if necessary.

When the program displays a new slide, the mouse pointer does not immediately appear. 

This is a function of PowerPoint.    After a new slide appears, move the mouse a few times to get the pointer to appear.    
PowerPoint won't show the mouse until you move it so that the pointer does not interfere with your presentation.

Long delays seem to occur randomly while viewing a presentation using Microsoft PowerPoint 97 (or a later version).

If you are using PowerPoint 97 (not the Viewer), you may want to turn off the AutoRecovery/AutoSave feature.    To do this, 
choose Options from the Tools menu, select the Save tab, and turn off the appropriate option. Since the presentations are quite 
large, saving the files may require a few moments.    If you are viewing a presentation at that time, the slide show will appear not to 
respond.    Even though you are viewing a slide, Microsoft PowerPoint 97 will still autosave any open files according to the set 
parameters.

A delay may also occur when you click on the Connect button.    Clicking on this button launches your browser, dials your phone (if 
necessary), and connects to the textbook’s Web site.    Depending on the speed of your computer, a few minutes may be required.

PowerPoint has difficulty displaying a presentation stored on a network drive or CD-ROM network server. 

Presentation Plus! must be installed locally on each computer that will run the presentations. Check to make sure that all relevant 
video and linked presentations are in the same directory with the main presentation you are trying to run. There may be noticeable 
delays running from a network. These delays can be caused by network speed, network traffic, or the server. See your network 
administrator if you are having difficulties. 



Clicking the Connect button does not launch your Web browser. 

You must have Netscape 4.0 or Explorer 4.0 (or later versions) installed on your computer.    When you click on the Connect 
button, a minute or two may be needed for the Web browser to launch and connect to the Internet.    If you don't have enough 
memory or you experience problems with the connection, the Web browser may not start properly.    You can quit the Presentation 
Plus! software and manually launch your Web browser.    Then go to the Web site that is specified on the slide.

A memory overflow error appears when printing slides, or only a portion (e.g., half) of a slide prints. 

If you try to print a slide that includes large art elements, your printer may display a memory overflow error or the printer may only 
print a portion of a slide.    First, make sure that you are printing in the black and white mode.    All of the presentations have been 
optimized so that only the most important information prints.    Background art should be turned off.    If you add your own slides, 
this may not be the case.    Choose Black and White from the View menu.    Then right-click on an object and set its black and 
white format.    For example, you can choose not to show an object in black and white mode.

Another option to try is to set the Print What: field in the Print dialog box.    Choose to print handouts (2 or 3 handouts per page).    
This option may also alleviate printing problems.

If you want to print slides with all of the art elements, you may need to add more memory to your printer.    See the manual that 
accompanies your printer for more information.

The screen goes black when you attempt to view the show.

PowerPoint 2000 loads the entire presentation into memory when you begin to view the show. This causes a delay of up to a 
minute or two when you start a presentation.

Answers are not provided for the crossword puzzles.

If you want to print the answers for a puzzle, click on the Start button and choose Run.    Type d:\extras\puzzles\pzmaker and 
press Enter to start the PuzzleMaker program.    (Be sure to use the drive letter that corresponds to your CD-ROM drive.)    After 
the program starts, choose to open a puzzle.    Select the puzzle you want and then choose to print it.    Exit the program when you 
are finished.

A slide show does not work properly after making changes to a presentation.

The Presentation Plus! slide shows contain many hyperlinks and action settings.    Make sure that you did not accidentally delete 
or change any of these.    To check for missing slides, use the Slide Sorter view.    In this mode, you can view several slides at one 
time. 

All of the chapter and unit presentations use the custom show feature for all features accessed through buttons on the left side 
of the slides (unless they are a linked presentation).

You should fully understand how custom shows function before you make any changes to these slides.    If, for example, you add a 
slide to one of these parts, you must also update the corresponding custom show list so that PowerPoint will know how to display 
the new slide.

None of the troubleshooting tips solve the problem.

If you have not customized the presentations, call the Glencoe/McGraw-Hill technical support number listed at the top of this page.

If you have difficulty customizing a presentation, you may want to access the Microsoft Web site at http://www.microsoft.com for 
assistance with your problem.    At this Web site, you can search through an online support database.    Another excellent source 
for help is the Microsoft PowerPoint discussion group at microsoft.public.powerpoint



Teaching Suggestions
Presentation Plus! combines many of the teaching tools you are already familiar with in one complete package.    Listed below 

are a few teaching suggestions that may be helpful for presenting Presentation Plus!, especially if you have never used a 

PowerPoint presentation before now.

· Check your equipment setup before class begins.    Configure your computer system and projector so that they work properly 
with each other.    If you have a videodisc player, make sure that it is working properly too.

· Install the Presentation Plus! software.    Follow the instructions provided in the package for installation.

· Work through at least one unit and one chapter presentation.    Check out all of the features.    Once you familiarize yourself 
with the flow and operation of one presentation, you will be ready to work with all of the others since they follow the same 
organization and navigation.

· Preview the presentations before using them in the classroom.    Use the teaching suggestions in the Teacher's Wraparound 
Edition to help you develop a plan to integrate the presentation into your lesson plan.

· If you have Microsoft PowerPoint 97 (or a later version), you can print the slides to use as handouts or as a teaching 
reference.    Open a presentation and choose Print from the File menu.    Using the Print What pop-up menu, you can 
choose to print 2, 3, or 6 slides per page.    This will save time and paper when printing the slides.    All slides have been set 
up to print in black and white so that the text shows.    To print only selected slides, click on the Slides radio button and then 
enter the desired print range (e.g., 5-12).

· Refer to the Teacher's Wraparound Edition and the print components that accompany the other integrated software 
components for teaching suggestions.

· Discuss proper note-taking techniques with your students.    Explain how to record important words, ideas, and phrases. The 
lecture notes that are provided as part of Presentation Plus! are not designed to be copied word for word.

· If you have Microsoft PowerPoint 97 (or a later version), you can customize any of the slide presentations to meet your 
classroom needs.    You can edit slides, add new ones, and delete unneeded slides. 
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Hyperlink
A hyperlink, which appears as underlined text, provides a way to jump from one slide (or location) to another slide (or location).    

When you click on a hyperlink, you go immediately to the location associated with that link.    If you accidentally select a hyperlink, 

you can click on the appropriate navigation button to return to where you were.




